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Notice

1.

10.

11.
12.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Notel) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

Www.renesas.com/contact/.

Trademarks
Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered trademarks
are the property of their respective owners.

© 2019 Renesas Electronics Corporation. All rights reserved.



General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an 1/0O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V. (Max.)
and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Vis (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LSI is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Disclaimer

By using this Renesas Solution Starter Kit (RSSK), the user accepts the following terms:

The RSSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSSK is
assumed by the User. The RSSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSSK,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSSK product:

This Renesas Solution Starter Kit is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
o power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The useris advised to take ESD precautions when handling the equipment.

The Renesas Solution Starter Kit does not represent an ideal reference design for an end product and does not fulfil
the regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Smart Configurator for RX
together with the e? studio IDE to create a working project for the RSSK platform. It is intended for users
designing sample code on the RSSK platform, using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into e? studio, but does not
intend to be a complete guide to software development on the RSSK platform. Further details regarding
operating the RX23W microcontroller may be found in the RX23W Group Hardware Manual and within the
provided sample code. The setup procedure for the RSSK Web installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX23W Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSSK Renesas Solution Starter Kit R20UT4446EG
hardware. for RX23W User’s Manual
Tutorial Manual Provides a guide to setting up RSSK Renesas Solution Starter Kit R20UT4447EG
environment, running sample code and for RX23W Tutorial Manual

debugging programs.
Quick Start Guide Provides simple instructions to setup the RSSK | Renesas Solution Starter Kit R20UT4448EG
and run the first sample. for RX23W Quick Start Guide
Smart Configurator | Provides a guide to code generation and Renesas Solution Starter Kit R20UT4449EG
Tutorial importing into the e? studio IDE. for RX23W Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSSK. Renesas Solution Starter Kit R20UT4445EG
for RX23W Schematics
Hardware Manual Provides technical details of the RX23W RX23W Group User’s Manual: | ROTUH0823EJ
microcontroller. Hardware




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Prmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification
RAM Random Access Memory
ROM Read Only Memory
RSSK Renesas Solution Starter Kit
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESAS

1. Overview

1.1 Purpose

This RSSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the e? studio
IDE Smart Configurator plug-in to create a working project for the RSSK platform.

1.2 Features

This RSSK provides an evaluation of the following features:
« Project Creation with e2 studio.

« Code generation using the Smart Configurator plug-in.
o User circuitry such as switches, LEDs and a potentiometer.

The RSSK board contains all the circuitry required for microcontroller operation.

R20UT4449EG0100 Rev. 1.00 Page 8 of 64
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Renesas Solution Starter Kit for RX23W 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator plug-in for the RX
family together with the e? studio IDE to create a working project for the RSSK platform. The tutorials help
explain the following:

Project generation using e? studio

Detailed use of the Smart Configurator plug-in for e2 studio
Integration with custom code

Building the project in €2 studio

The project generator will create a tutorial project with two selectable build configurations:
e ‘HardwareDebug’ is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’is a project with optimised compile options (level two) and ‘Outputs debugging information’
option not selected, producing code suitable for release in a product.

These tutorials are designed to show you how to use the RSSK and are not intended as a comprehensive introduction to
the e? studio debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more
in-depth information.

R20UT4449EG0100 Rev. 1.00 Page 9 of 64
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Renesas Solution Starter Kit for RX23W 3. Project Creation with e? studio

3. Project Creation with e? studio

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX23W
MCU, ready to generate peripheral driver code using Smart Configurator. This project generation step is
necessary to create the MCU-specific source, project and debug files.

3.2 Creating the Project

e Start e? studio and select a suitable location | [EEEEEEEE
for the project workspace. Select a directory as workspace

€ studio uses the workspace directory to store its preferences and development artifacts.

Workspace: | C\Workspace v|E Browse... i

[ Use this as the default and do not ask again

e In the Welcome page, click ‘Create a new
C/C++ project’.

Import existing ¢ studio projects from the flesystem or archive o through tutortals

Review the IDE's most ercely contestad preferences Ty out the samples

Open  fle from the lesystem Find out what i new

1 ways show welcome at tart

e In the ‘Templates for New C/C++ Project’ e? New C/C++ Project

H H ‘ ) _> ‘
dialog, selecting ‘Renesas RX ’ Renesas Templates for New C/C+-+ Project
CC-RX C/C++ Executable Project’.
e Click ‘Next'’.
All GCC for Renesas RX C/C++ Executable Project
Make = A C/C++ Executable Project for Renesas RX using
Renesas DEbUi the GCC for Renesas RX Toolchain.
GCC for Renesas RX C/C++ Library Project
=== A C/C++ Library Project for Renesas RX using
the GCC for Renesas RX Toolchain.
| Renesas CC-RX C/C++ Executable Project
fE\ A C/C++ Project for Renesas RX using the
Renesas CCRX toolchain.
Renesas CC-RX C/C++ Library Project
=== A C/C++ Library Project for Renesas RX using
the Renesas CCRX toolchain,
?\ < Back Mext > Finish Cancel
R20UT4449EG0100 Rev. 1.00 RENESAS Page 10 of 64
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Renesas Solution Starter Kit for RX23W 3. Project Creation with e? studio

* Enter the project name ‘SC_Tutorial’. Click | |

‘Next'. New Renesas CC-RX Executable Project p—
MNew Renesas CC-RX Executable Project |
Project name: |5C_Tutorial
Use default location
C:\Workspace\SC_Tutorial Browse...
Create Directory for Project
default
Weorking sets
[[] Add project to working sets New.
Select...
® < Back MNext > FEinish Cancel
* In the ‘Select toolchain, device & debug | [N
settings’ dialog, select the options as ShOwn | | new Renesas cc-Rx Executable Project >
in the Screenshot Opposite_ Select toolchain, device & debug settings 1 3
e In “Toolchains’ choose ‘Renesas CCRX'. Toolchain Settings
. Language: @®C OC++
e The R5F523W8AXBL MCU is found under || ™ -~~~ -
RX200 - RX23W - Toolchain Version: | v3.01.00 ~
RX23W - 85 p|n. RTOS: Neone ~
. Manage Toolchains...
e Select 'E2 Lite (RX)' from the pulldown and Hanasieneh
' . n Y Device Settings Configurations
check 'Create Release Configuration' check e o o
Target Device: | R3F523WaAxBL Create Hardware Debug Configuration
bOX' Unlock Devices... IEZ Lite (RX) VI
b CIiCk ‘NeXt, Endiar: | itde - [] Create Debug Configuration
Project Type: Default RX Simulator -
Create Release Configuration
@ < Back I Next > I I Einish | Cancel

e In the ‘Select Coding Assistant Tool’ dialog,
select ‘Smart Configurator’. New Renesas CC-X Execttable Project =<

Select Coding Assistant settings |

o Click ‘Next'. =t
Edlsmart Configurator

Use Peripheral Code Generator
Use FIT Medule Download FIT Modules

Smart Configurator is  single User Interface that combines the functionalities of Code Generator and FIT Configurator which
imperts, configures and generates different types of drivers and middleware modules.

Smart Configurater encompasses unified clock configuration view, interrupt configuration view and pin configuratien view.

Hardware resources conflict in peripheral modules, interrupts and pins occurred in different types of drivers and middleware

modules will be notified.

(Smart Configurator is available only for the supported devices)

MCU Hardware

? . v

User Application E
Driver and Middleware i
Driver Code FIT Modules o
Configured in GUI Selected in GUI Eh
and Generated and Imported m
c

o

o

il

@ < Back Next > e

R20UT4449EG0100 Rev. 1.00 RRENESAS Page 11 of 64
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Renesas Solution Starter Kit for RX23W 3. Project Creation with e? studio

o Click ‘Next. e

New Renesas CC-RX Executable Project

Settings The Contents of Files to be Generated

‘What kind of initialization routine would you like to create?

[] Use Renesas Debug Virtual Console
Humber of [/ Streams:
20 z

@ <Back [ Neds Gl

e A summary dialog will appear, click ‘Finish’ to I

New Renesas CC-RX Executable Project

complete the project generation. _ : |
Summary of project "SC_Tutarial”

TOOLCHAIN NAME : Renesas CCRX
TOOLCHAIN VERSION : v3.01.00

GENERATION FILES

@ T lBeck | Mens el

Information

o Wait for file generation to start.

@l Smart Configurator operation in progress

Preparing startup code...

Cancel

e In future, to skip the pop-up message on the ? Open Associated Perspective?
rlght’ check the AIWa'yS use this Sett’Ing @>% This kind of project is associated with the Smart Configurator perspective, Do you
check box and click on 'Open Perspective'. &P vant to open this perspective now?

e The perspective changes automatically when

the Smart Configurator starts up.
__Qpen Perspective No

R20UT4449EG0100 Rev. 1.00 RENESAS Page 12 of 64
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Renesas Solution Starter Kit for RX23W 4. Smart Configurator Using the e? studio

4. Smart Configurator Using the e? studio

4.1 Introduction

The Smart Configurator plug-in for the RX23W has been used to generate the sample code discussed in this
document. Smart Configurator for e? studio is a plug-in tool for generating template ‘C’ source code and
project settings for the RX23W. When using Smart Configurator, it provides the user with a visual way of
configuring the target device, clocks, software components, hardware resources and interrupts for the project;
thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are named ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

By following the steps detailed in this Tutorial, the user will generate an e? studio project called SC_Tutorial.
The fully completed Tutorial project is contained in the RSSK Web Installer
(https://www.renesas.com/rsskrx23w/install/e2) and may be imported into e? studio by following the steps in
the Quick Start Guide. This Tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for e? studio.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the virtual COM port in a terminal program and also on the PMOD display connected to the RSSK.

* USB serial communication requires a USB serial driver manufactured by FTDI. Please download from the
following URL. Please contact FTDI for driver installation and questions.
https://www.ftdichip.com/Drivers/D2XX.htm

Following a tour of the key user interface features of Smart Configurator in the tabbed pages (board, clocks,
components and pins), as well as a demonstration of building a project, the reader is guided through each of
the peripheral function configuration pages and familiarised with the structure of the template code, including
the process of adding their own code to the user code areas provided by the Smart Configurator.

R20UT4449EG0100 Rev. 1.00 REN ESNS Page 13 of 64
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Renesas Solution Starter Kit for RX23W 4. Smart Configurator Using the e? studio

4.2 Project Configuration using Smart Configurator

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the RX Smart Configurator User's Guide: e? studio.
You can download the latest document from: https://www.renesas.com/smart-configurator.

The Smart Configurator initial view is displayed as illustrated in Figure 4-1.

€ Workspace - SC_Tutorial/SC_Tutorial.scfg - €° studio

File Edit Navigate Search Project RenesasViews Run Window Help

45 Debug [ SC_Tutorial HardwareDebug il [ B -~ @i~ N HCAL AR R A AR
|| | R C/Cor |5 Smart Configurator %5 Debug

5 Project Bxplorer 23 = B { SC_Tutorialscfg = B  §IMCUPackage =B
5% Y o o : - B
verview information k¢ = N »
v (= SC_Tutorial de |\ —
[l Includes . General Information @ o
2 src

2] SC_Tutorial HardwareDebug.launct  This editor allows you to modify the settings stored in configuration file (.scfg)
56 SC_Tutorial.scfg

Board

Allow board and device selection

Clocks Application under

development
Allow clock configuration

= Components
[M\dd\ewara l
‘Components Device - = o ®
driver | RTOS |
Allow software component selection and configuration
e L i
Pins
Allow general pin configuration and pin configuration for selected software component
v
< > Overview| Board | Clocks| Compenents| Pins | Interrupts ¥ Legend
& Consale 52 REEE MEB~-gr=0 sole @ Smart Browser 53 =0
Smart Canfigurator Output & & | -
MB56ARA12: File generated

smc_gen\r pincfg\Pin.h
smc_gen\r_pincfg\Pin.c

smc_gen\general\r smc interrupt.c Context Help  User's Manual  Technical Update  Application Notes Tool News Notifications

smc_gen\general\r smc interrupt.h

MBOBRORR2: Code generation is successful Total: 1

MB3800884: File modified:src\smc gen\r config\r bsp config.h

MB58@BE12: File generated Device: -
MB6BBeRe2: File generated

Meceeeee2: File generated

L

0items selected

i

Figure 4-1 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured e? studio project that builds and runs without error.
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Renesas Solution Starter Kit for RX23W 4. Smart Configurator Using the e? studio

4.3 The ‘Board’ tabbed page

On the ‘Board’ tabbed page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-2.

8k SC_Tutorial.scfg 52 =
Device selection e
Device selection o

Board: | Custom User Board ~

Device: | RIF323WeAXBL

Download more beards...

Overview Clocks | Components| Pins | Interrupts

Figure 4-2 Board configuration page

431 Board configuration page

Make sure that ‘Custom User Board'’ is selected for the ‘board:’.

8% SC_Tutorialscfg 52

Device selection

Device selection

Board: ICustom User Board VI

Device: | R5F323WBAxEL

Download more boards...

Figure 4-3 Select board
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Renesas Solution Starter Kit for RX23W 4. Smart Configurator Using the e? studio

4.4 The ‘Clocks’ tabbed page

The ‘Clocks’ tabbed page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected in the
r_bsp_config.h file in \src\smc_gen\r_config.

441 Clocks configuration

Figure 4-4 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In the tutorial, the HOCO clock is used as the clock
source. Select the route using the HOCO clock by the selector.

* An exclamation mark 14 appears in the USB clock position, but ignore it because this project does not use
the USB clock.

48k *SC_Tutorial.scfg 53 = &
Clocks configuration % &
vee: | 33 )

USB clock (UCLK)
54 (MHZ) g\

]
[~

SCKCR (FCLK[3:0])

FlashiF clock (FCLK)
Main clock —— x112 v —_— 70 (MH2Z)

SCKCR (ICLK[3:0]) System dock (ICLK)

— xl v 510 (MHz)
SCKER (PCLKALZOD) Peripheral medule clock A (PCLKA)
J | xi - =0 (MH2)
EERCRBAlREL] Peripheral module clock B (PCLKB)
Sub-clock Rl 20 (MH2)
Ld
SCKCR (PCLKD[3:01) Peripheral module clock D (PCLKD)
= - =g (MHZ)
CKOCR (CKODIV[2:0]) CLKOUT pin
v | HOCO clock | x1/4 -
8]
CACHCLK
54 (MHzZ)
LOCO clock ‘

L

—
—

IWDT-dedicated low-speed clock ‘

Frequency divider

Bluetooth-dedicated clock 1132 1716 1/8
/32,1716, 1/8
2 < | o This divider is set by BLE FIT module L= ERE L

Fraquency:

$ To Bluetooth 5.0

Bluetooth-dedicated low speed clock
p To Bluetooth 5.0

Frequency: 32.768 (kHz)

Overview | Board Components | Pins| Interrupts

Figure 4-4 The ‘Clocks’ Tabbed page
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Renesas Solution Starter Kit for RX23W 4. Smart Configurator Using the e? studio

4.5 The ‘Components’ tabbed page

Drivers and middleware are handled as software components in Smart Configurator. The Components page
allows the user to select and configure software components.

{8t *SC_Tutorialscfg 53

Software component configuration

Components | =) -
%
type filter text
v = Startup
v [= Generic
& rbsp

Overview | Board CIUcksICDmpUnentsIPins Interrupts
Figure 4-5 The ‘Components’ tabbed page

451 Add a software component into the project

Smart Configurator supports five types of software components: Startup, Drivers, Middleware, Application and
RTOS. In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple
project containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click the ‘Add component’ & icon.

§8% SC_Tutorial.scfg 33
Software component configuration

Components = 2 - Configure

type filter text

w [ Startup
v [ Generic

& rbsp

Figure 4-6 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

e? New Component

Software Component Selection

Select component from those available in list dj
Type All ~
Function Al
Filter
iddleware
Application
ComporRTOS

R 8-Bit Timer Code Generator 1.6.0
8 Buses Code Generator 1.60
8 Clock Frequency Accuracy Me...  Code Generator 1.60

Figure 4-7 Add a Software component (2)
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Renesas Solution Starter Kit for RX23W

4. Smart Configurator Using the e? studio

4.5.2 Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. CMT1 and CMT2 will be used as

timers in de-bouncing of switch interrupts.

Select ‘Compare Match Timer’ as shown in Fig

ure 4-8 below then click ‘Next’.

e* New Component

Software Component Selection
Select component from those available in list tlj
Type Drivers ~
Function | All ~
Filter |
I

Components Type Version €3

2 Comparator Code Genarior 1.6.0

e . Code Generatar 1.8.0 |

Complementary PWM Mode Ti... Code Generator 1.6.0

## Continuous Scan Mode 51240 Code Generator 160

B CRC Caleulator Code Generator 1.6.0

B D/A Converter Code Generator 1.6.0

# Data Operation Circuit Code Generator 1.6.0

H# Data Transfer Controller Code Generator 1.6.0

2 DMA Controller Code Generator 150

- .. PR . P v

< >
Show only latest version
Description

This seftware component provides configurations for 18-bit/32-bit timer with

module CMT/CMTW and can generate interrupts at set intervals,

Download more software compenents

Configure general settings...

® < Back I Next > I | Finish | Cancel

Figure 4-8 Select Compare Match Timer

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTO0’ as shown in Figure 4-9

below then click ‘Finish’.

e® New Component

Compare Match Timer

Configuration name: |Config_CMTO |

Resource: I CMTO ~ I

® < Back Next > Cancel

Figure 4-9 Select Resource - CMTO
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Renesas Solution Starter Kit for RX23W 4. Smart Configurator Using the e? studio

In ‘Config_ CMTOQ’ configure CMTO as shown in Figure 4-10. This timer is configured to generate a high
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

Components =] 2 - Configure
% 5 Count clock setting

type filter text @ PCLK/S (OPCLK32 (OPCLE/28 (DPCLE/S12
;' &= Startup Compare match setting

w [ Generic Interval value |1 I Ims VI (Actual value: 1)
.o Dri\':;s'-bs" Register value (CMCOR) [337 |

~ [ Timers Compare match interrupt (CMID)

« Config CMTO Priority [Level 10 ~|

Figure 4-10 Config_CMTO setting

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT1’ as shown in Figure 4-11 below then click ‘Finish’.

e New Component

Add new configuration for selected component

Compare Match Timer
Cenfiguration name: |CunfigicMTDW |

Resource: |CMTD V|

CMT3 |

@ < Back Next > o
Figure 4-11 Select Resource — CMT1

Navigate to the ‘Config_CMT1’ and configure CMT1 as shown in Figure 4-12. This timer is configured to
generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

Components = ::: ~ Configure
% = Count clock setting
PCLK/8 PCLK/32 PCLE/128 PCLE/512
type filter text O i~ O
v @ Startup Compare match setting
w [ Generic Interval value IZD I Ims VI (Actual value: 20)
& rbsp Register value (CMCOR) [16874 |
w [= Drivers
v [= Timers Compare match interrupt (CMIT)
& Config_CMT0 - T
‘_ Config_ CMT Pricrity fLevel 10 : I
Figure 4-12 Config_CMT1 setting
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Renesas Solution Starter Kit for RX23W 4. Smart Configurator Using the e? studio

Click the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-13 below then click ‘Finish’.

e New Component

Add new configuration for selected component

Compare Match Timer
Cenfiguration name: |CunfigicMTDW |
Resource: CMTO ~

CMTO

@ < Back Next > Cancel
Figure 4-13 Select Resource — CMT2

Navigate to the ‘Config_ CMT2’ and configure CMT2 as shown in Figure 4-14. This timer is configured to

generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

Components = o Configure
+ = Count clock setting
i (D PCLK/E (D PCLK/32 (O PCLK/28 (®) PCLK/512
type filter text
v @ Startup Compare match setting
w [= Generic Interval value IZDD I Ims VI(ActuaI\faIue: 200.00237)
- & rbsp Register value (CMCOR) [10546 |
v rivers
v [= Timers Compare match interrupt (CMI2)
& Config_CMTD L : :
& Config CMT1 Priority |Level 10 i VI
& Config_CMT2

Figure 4-14 Config_CMT2 setting
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Renesas Solution Starter Kit for RX23W

4. Smart Configurator Using the e? studio

4.5.3 Interrupt Controller

Referring to the RSSK schematic, SW1 is connected to IRQ1(P31) and SW2 is connected to IRQO (P30).

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’
Select ‘Interrupt Controller’ as shown in Figure 4-15 then click ‘Next'.

e’ New Component

Software Component Selection tlj-

Select component from those available in list

Type IDrwers VI
Function | All v
Filter | |

Components Type Version ()

B Event Link Controller Code Generator 1.5.0

8 Group Scan Mode S12AD Code Generator 1.6.0

B 12C Master Mode Code Generator 160

£ 12C Slave Mode Code Generator 1.6.0

H Interrupt Controller Code Generator 1.8.0 |

Low Power Consumption Code Generator 180

8 Low Power Timer Code Generator 13.0

H Normal Mode Timer Code Generator 160

B Phase Counting Mode Timer Code Generator 180 v

e s e PR . arn

< >

Show only latest version

Description

This software component generates twe units (unit 0, unit 1) of an en-chip 8-bit
timer (TMR) module that comprise two 8-bit counter channels, totaling four
channels.

Download more software components

Configure general settings...

® < Back I Mext > I I FEinish I Cancel

Figure 4-15 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘ICU’ as shown in Figure 4-16

below then click ‘Finish’.

e’ New Component

Interrupt Controller

Configuration name: | Cenfig_ICU |

Resource: IcU ~

® < Back MNext > Cancel

Figure 4-16 Select Resource —ICU
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4. Smart Configurator Using the e? studio

Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-17

below.
Components =] ;.;:9 ~ Configure
% = Software interrupt setting
type filter text [ Software interrupt Level 15 (highest]
v [ Startup NMI pin interrupt setting
Ve ane”( CINMI pin interrupt Falling edge No filter
& rbsp
v [ Drivers IRQD setting
~ [= Interrupt
= CD:ﬁg_ICU Edrao Detection type | Falling edge ~|  Digital filter | No filter
v & Timers Priority | Level 15 (highest) v
& Config_CMTO
f.' Config_CMT1 IRQ1 setting
. Config_CMT2 T
& Lonfig Elrar Detection type i Digital filter | No filter
Priority | Level 15 (highest) ~
IR setting
[Jiroe Low level Mo filter
Level 15 (highest]
IRQS setting
[Jiras Low level Mo filter
Level 15 (highest]
IRQE setting
[JIrcse Low level Mo filter
Level 13 (highest]
IRQ7 setting
ka7 Low level Mo filter

Level 13 (highest)

Figure 4-17 Config_ICU setting
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4. Smart Configurator Using the e? studio

454 Ports

Referring to the RSSK schematic, LEDO is connected to P41, LED1 is connected to P42, LED2 is connected
to P43 and LED3 is connected to P44. PE3 is used as one of the LCD control lines, together with PB3, P03

and PJ3.

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’
Select ‘Ports’ as shown in Figure 4-18 then click ‘Next'.

e’ New Component

Software Component Selection tlj-

Select component from those available in list

Type IDrwers

Function | All v
Filter | |
Components Type Version @

8 Mormal Mode Timer Code Generator 1.6.0
8 Phase Counting Mode Timer Code Generator 180
B Port Output Enable Code Generator 1.6.0
: Bf Ports Code Generator 1.8.0
H PWM Mode Timer Code Generator 1.6.0
B Real Time Clock Code Generator 140
8 SCI/SCIF Asynchronous Mode Code Generator 1.6.0
8 SCI/SCIF Clock Synchronous M... Code Generator 1.6.0
BSmgIE Scan Mode 512AD Code Generator 180 v
Hie . e e e PR . arn
< >
Show only latest version
Description
This software component provides cenfigurations for General Purpose Input/Output.
Commeon features such as reading, writing, and setting the direction of ports and
pins can be configured. Enabling features such as open-drain outputs and internal
pull-ups are also supported.

Download more software components

Configure general settings...

@ < Back I MNext > I I Einish I Cancel

Figure 4-18 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-19

below then click ‘Finish’.

e’ New Component

Add new config ion for sel d p tlj-

Ports

Canfiguration name: | Config_PORT

Resource: PORT

® < Back Mext > Cancel

Figure 4-19 Select Resource — PORT
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W

type filter text

v (= Startup

w [= Drivers

w [~ Generic
@ rhsp

v [ Interrupt
& Config_ICU
v [= I/OPorts
& Config_PORT
w [ Timers
& Config_CMTO
& Config_CMT1
& Config_CMT2

=] = - Configure

Port selection  PORTO PORT4 PORTE PORTE PORT

grorm

[JroRTZ [ PORT3
C1PORTC CIPORTD

Figure 4-20 Select Port selection

Tick the tickboxes for ‘PORTOQ’, ‘PORT4’, ‘PORTB’, PORTE’ and ‘PORTJ’ as shown in Figure 4-20 below.

Compone...

Navigate through each of the ‘PORTX’ tabs, configuring these four I/O lines and LCD control lines as shown in
Figure 4-21, Figure 4-22, Figure 4-23, Figure 4-24 and Figure 4-25 below. Ensure that the ‘Output 1’ tick

box is checked, except for PJ3 under the ‘PORTJ’ tab. Start with the 'PORTO' tab.

Components = :%:D ~ Configure
= Port selection | PORTO | PORT4 PORTE  PORTE PORT)
type filter text
v [ Startup [JApply to all
v & Generic Unused GPIO In Out Pull-up
& r_bsp
N %[/E::\rl:rtserrupt po3
& Config ICU OUnused GPI0. Ol Pull-up
w [= |/O Ports
& Config_PORT P05
v (& Timers @Unused GPIO. Oin Qout  [JPull-up
& Config_CMTD
& Config CMT1 po7
& Config_CMT2
®Unused GPIO. Oin O 0ut [JPull-up

Qutput 1

Output 1

Output 1

Output 1

Figure 4-21 Select ‘PORTO’ tab
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Select ‘PORT4’ tab.

Components = 2 Configure

T Port selection PORTO | PORT4 | PORTE PORTE PORT)

type filter text

~ [= Startup [J Apply te all
vE aneric Unused GPIO In Out Pull-up Qutput 1
W& rbsp
~ [= Drivers paD
v [= Interrupt
& Config_ICU ®UnusedGPIO Clin- O 0ut  [JPull-up Output 1
v = /O Ports
& Config_PORT P41
v (= Timers OUnused GPIO. O Pull-up
& Config_CMTOD
& Cont 2
onfig_|
« ! OUnused GPIO. O Pull-up
P43
OUnused GPIO. On Pull-up
P44
OUnused GPIO Ol Pull-up
P45
®Unused GPIO Oin O 0ut  [JPull-up Qutput 1
P46
®Unused GPIO Oin Q0ut  [JPull-up Output 1
P47
® Unused GPIO Clin O 0wt [JPull-up Output 1

Figure 4-22 Select ‘PORT4’ tab

Select ‘PORTB’ tab.

Components =] = Configure
W W Port selection PORTO PORT4 | PORTE | PORTE PORT)
type filter text
w [= Startup [ Apply to all
v & aneric Unused GPIO In Out Pull-up CMOS output Qutput 1 High-drive cutput
& r_bsp
w [= Drivers PEO
v [= Interrupt
& Config_ICU ®UnusedGPIO. OIn O 0wt [JPull-up | CMOS output Output 1 High-drive output
v [= /O Ports
& Config_PORT PB1
= T.i_mer; ® Unused GPIO O1In O 0ut  [JPull-up CMOS output Qutput 1 High-drive output
& Config_CMTO
& Config_CMT1 PB3
& Config_CMT2
(Z) Unused GPIO Pull-up CMOS output v |EAoutput 1| [JHigh-drive output
PES
®Unused GPIO O'in O 0wt [JPull-up CMOS output Qutput 1 High-drive cutput
PET
®UnusedGPIO OlIn O0ut  [JPull-up | CMOS output Output 1 High-drive output
Figure 4-23 Select ‘PORTB’ tab
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Select ‘PORTE’ tab.

Components = 2 - Configure
B = Port selection  PORTD  PORT4  PORTE | PORTE | PORT)
type filter text
w [ Startup [ Apply to all
vE aneric Unused GPIO In Out Pull-up CMOS output Output 1 High-drive output
& r_bsp
~ [= Drivers PED
v [ Interrupt
& Config_ICU ®Unused GPIO. OIn - O0ut  [JPull-up | CMOS output Output 1 High-drive output
v [= I/O Ports
& Config_PORT PE1
v & Timers ®Unused GPIO Oln - OOut  [JPull-up  CMOS output Output 1 High-drive output
& Config_CMTD
.{ Config_CMT1 PE2
& Config_CMT2
® Unused GPIO. OIn O 0Out  [JPull-up CMOS output Output 1 High-drive output
PE3
OUnused GPIO Cin Pull-up | CMOS output v | [40utput 1]  [JHigh-drive output
PE4
®UnusedGPIO O1In - Q0Out  [JPull-up CMOS output Output 1 High-drive output
Figure 4-24 Select ‘PORTE’ tab
Select ‘PORTJ' tab.
Components = o Configure
T Port selection PORTO PORT4 PORTB PORTE | PORT)
type filter text
v [ Startup [Japply to all
ve aneric Unused GPIO In Qut Pull-up  |CMOS output Output 1 High-drive output
W rbsp
w [ Drivers P13
v [ Interrupt
& Config_ICU OUnused GPIO Cin Pull-up | CMOS output v| [JOutput1 [JHigh-drive output
v (= /0 Ports
& Config_PORT
v [= Timers
& Config_CMT0
@ Config_CMT1
& Config_CMT2

Figure 4-25 Select ‘PORTJ’ tab
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4.5.5 SCI/SCIF Asynchronous Mode

In the RSSKRX23W, SCI8 is connected via the FT234XD USB-UART converter to provide a USB virtual COM
port as shown in the schematic.

Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select
‘SCI/SCIF Asynchronous Mode’ as shown in Figure 4-26 then click ‘Next'.

e® New Component

Software Component Selection
Select component from those available in list .Hj
Type IDrivers VI
Function | All ~
Filter | |
7
Components Type Version &
£ Real Time Clock Code Generator 1.4.0
£ SCI/SCIF Asynchronous Mode  Code Generator 1,6.0 |
£ SCI/SCIF Clock Synchronous M... Code Generator 1.6.0
$Sing\e5can Mode 51240 Code Generator 1.8.0
8 Smart Card Interface Mode Code Generator 1.6.0
8 SPI Clock Synchronous Mode Code Generator 1.6.0
$SPIOperation Mode Code Generator 1.6.0
B]‘u‘oltage Detection Circuit Code Generator 1.6.0
## Watchdog Timer Code Generator 1.6.0 v
< >
Show only latest version
Description
This software component provides configurations for SCI{SCIF) single(multi-
processor) asynchronous mode.

Download more software compenents

Configure general settings...

@ < Back I Next = I | Finish | Cancel

Figure 4-26 Select SCI/SCIF Asynchronous Mode

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as

shown in Figure 4-27 below.

Figure 4-27 Select Work mode — Transmission/Reception

e* New Component

Add new configuration for selected component |

SCI/SCIF Asynchronous Mode

Configuration name: | Config_SCI1 |

Work mode: Transmission ~

Transmission

Resource:
Reception

Transmission/Reception
Multi-processor Transrission
Multi-processor Reception
Multi-processor Transmission/Reception

® < Back Next > Cancel
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In ‘Resource’, select ‘SCI8’ as shown in Figure 4-28 below.

e’ Mew Component

Add new configuration for selected component

SCI/SCIF Asynchronous Mode

Configuration name: Config_SCH |

Work mode: Transmission/Reception ~

Resource: scn ~

sCi
SCI3
sCI2

® < Back MNext = Cancel

Figure 4-28 Select Resource — SCI8

Ensure that the ‘Configuration name’ updates to ‘Config_SCI8’ as shown in Figure 4-29 below then click

‘Finish’

e’ New Component

Add new configuration for selected component 'Ha'
SCI/SCIF Asynchronous Mode
Configuration name: IConfig_SCIS I
Work mode: Transmission/Reception ~
Resource: SCI8 e
® < Back MNext = Cancel

Figure 4-29 Ensure Configuration name - Config_SCI8
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Configure SCI8 as shown in Figure 4-30. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on

RXD8 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

Components

type filter text

L

SR

v [= Startup
~ [ Generic
& rbsp
w [= Drivers
~ [ Interrupt
& Config_ICU
~ [= /O Ports
& Config_PORT
v [ Communications
& Config_SCI8
» [= Timers
@ Config_CMTO
& Config_CMT1
& Config_CMT2

Configure
Start bit edge detection setting

(O Low level on RXDS pin

Data length setting
()9 bits

Parity setting

(® Mone

Stop bit length setting
® 1 bit

Transfer direction setting
(®) LSB-first
Transfer rate setting

Transfer clock

Bit rate
[]Enable modulation duty correction
SCK2 pin function

Moise filter setting
[[]Enable noise filter

Hardware flow control setting

(® Mone

Data handling setting

Transmit data handling

Receive data handling

Interrupt setting

Enable reception error interrupt (ERIZ)
TXI8, RXI8, TEIE, ERIS priority

Callback function setting

[ Transmission end

@ Falling edge on RXDE pin

@) 8 bits
(D) Even
(O 2 bits

() MSB-first

Internal clock

16 cycles for 1-bit period

~|

SCK2 is not used

Clock signal divided by 1

O cTses

Data handled in interrupt service routine

Data handled in interrupt service routine

Level 15 (highest)

Reception end

7 bits

O odd

(bps) (Actual value: 19176.136, Error: -0.124%)

Reception error

Figure 4-30

Config_SCI8 setting
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4.5.6 SPI Clock Synchronous Mode

In the RSSKRX23W, SCI12 is used as an SPI| master for the Pmod LCD on the PMOD2 connector as shown

in the schematic. Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select
‘Drivers’ . Select ‘SPI Clock Synchronous Mode’ as shown in Figure 4-31 then click ‘Next'.

e® New Component

Software Component Selection tlj-

Select component from those available in list

Type Drivers ~
Function | All ~
Filter |

Components Type Version L

B Real Time Clock Code Generator 140

## 5CI/SCIF Asynchronous Mode Code Generator 1.6.0

8 SCI/SCIF Clock Synchronous M...  Code Generator 1.6.0

$Sing\e5can Mode 51240 Code Generator 1.8.0

## Smart Card Interface Mode Code Generator 1.6.0

4 5PI Clock Synchronous Made Code Generator 1.6.0 |

$SP|OpErEtiUI"I Mode Code Generator 1.6.0

$‘u’n|tage Detection Circuit Code Generator 160

H# Watchdog Timer Code Generator 1.6.0 v

< >
Show only latest version
Description

This component provides clock synchronous operation of RSP or SCI (Simple SPI

bus). It includes 4 transfer modes: Slave transmit/receive, Slave transmit, Master

transmit/receive and Master transmit.

Download more software compenents

Configure general settings...

@ <8k | MNed> |[ Ensh || Cancel

Figure 4-31 Select SPI Clock Synchronous Mode

In ‘Add new configuration for selected component’ dialog -> Operation, select ‘Master transmit only’ as shown
in Figure 4-32 below.

e* New Component

Add new configuration for selected component |

5PI Clock Synchronous Mode

Configuration name: | Config_RSPID |

Operation: Slave transmit/receive ~

Slave transmit/receive
Resource:

Slave transmit only

Master transmit/receive

@ < Back Mext = Cancel

Figure 4-32 Select Operation — Master transmit only
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In ‘Resource’, select ‘SCI12’ as shown in Figure 4-33 below.

e’ Mew Component

Add new configuration for selected component

5PI Clock Synchronous Mode

Configuration name: Config_RSPID

Operation: Master transmit only

Resource: RSPID

R5PID
sCn
SCl5
SCI3

® < Back MNext = Cancel

Figure 4-33 Select Resource — SCI12

Ensure that the ‘Configuration name’ updates to ‘Config_SCI12’ as shown in Figure 4-34 below then click

‘Finish’

e’ New Component

Add new configuration for selected component 'Ha'
SPI Clock Synchronous Mode
Configuration name: IConfig_SCI‘IZ I
Operation: Master transmit only ~
Resource: 5CI12 ~
® < Back MNext = Cancel

Figure 4-34 Ensure Configuration name - Config_SCI12
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Configure SCI12 as shown in Figure 4-35.

Ensure the ‘Transfer direction’ is set as ‘MSB-first' and the ‘Bit

rate’ is set to 6000 kbps. All other settings remain at their defaults.

Components =] = Configure
% = Transfer direction setting
type filter text OLse-first
v [= Startup Data inversion setting
v = aneric ® Normal
& rbsp
v & Drivers Transfer speed setting
v [= Interrupt
& Config_ICU Transfer clock
v [= I/OPorts .
& Config PORT Bit rate

w [= Communications
& Config_5CI2
& Config_5CI8
w [= Timers
& Config_CMTD
& Config_CMT1
& Config_CMT2

Clock setting
[JEnable clock delay

Data handling setting

Transmit data handling

Interrupt setting

TXN2, TEN2 priarity

Callback function setting

[ Transmission end

[JEnable modulation duty correction

(®) MSB-first

(O Inverted

£

Internal clock (SCK12 pin functions as clock output pin)

G000 (kbps)  (Actual value: 6750, Error: 12.5%)

[JEnable clock polarity inversion
Data handled in interrupt service routine

Level 15 (highest)

Figure 4-35

Config_SCI12 setting
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4.5.7 Single Scan Mode S12AD

We will be using the S12AD in Single Scan Mode on the ANO0OO input, which is connected to the RV1

potentiometer output on the RSSK. Click ‘Add component’ & icon. In ‘Software Component Selection’ dialog
-> Type, select ‘Drivers’ . Select ‘Single Scan Mode S12AD’ as shown in Figure 4-36 then click ‘Next'.

e* New Component

Software Component Selection |

Select component from those available in list

Type IDrivers VI
Function |All ~
Filter | |
s
Components Type Version 2
H# Real Time Clock Code Generator 140
H# 5CI/SCIF Asynchronous Mode Code Generator 160
B]SCVSCIFCIO:I(Syn(hronousM... Code Generator 1.6.0
1 Single Scan Mode S12AD Code Generator 1.8.0 |
B Smart Card Interface Mode Code Generator 160
## 5Pl Clock Synchronous Mode Code Generator 1.60
## 5PI Operation Mode Code Generator 160
$‘u’ultage Detection Circuit Code Generator 1.6.0
$Watchdng Tirmer Code Generator 160 v
< >
Show only latest version
Description
This software component provides single scan mode configurations for 12-Bit A/D
Converter which the analog inputs arbitrarily selected are converted for only once in
ascending channel order.

Download mere software components

Configure general settings...

® < Back I Mext = I | Finish | Cancel

Figure 4-36 Select Single Scan Mode S12AD

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘S12AD0’ as shown in Figure

4-37 below then click ‘Finish’.

e* New Component

Add new configuration for selected component |

Single Scan Mode 51240
Configuration name: | Config_512AD0 |

Resource: 512AD0 ~

® < Back Mext = Cancel

Figure 4-37 Select Resource — S12AD0
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Configure S12ADO0 as shown in Figure 4-38 and Figure 4-39. Ensure the ‘Analog input channel’ tick box for
ANO0O0O is checked and the ‘Start trigger source’ is set to ‘Software trigger’. All other settings remain at their

v [= A/D Converter
& Config_5124D0
~ [= /O Ports
& Config_PORT
w [ Communications
& Config_5C12
& Config_SCI8
v (= Timers
& Config_CMTO
& Config_CMT1
& Config_CMT2

[] Temperature sensor output

Conversion start trigger setting

Start trigger source

defaults.
Components = e Configure
W ~ Basic setting
type filter text Analog input mode setting
~ [ Startup [JDouble trigger mode
v (= Generic
& rbsp Analog input channel setting
v (= Drivers [Janoo1 ] Ano02 [Janooz [ Anoo4
v (& Interrupt ] aMoDs ] ANDDS ] ANDOT ] amMo1s ] AND17
& Config ICU ] anots ] ANo19 ] AND20 ] an027

[Jinternal reference veltage

I Software trigger

Interrupt setting

* Advance setting

Add/Average AD value setting

] AN0DO ANOO1T
ANODS ANODE
ANO18 ANO19

Temperature sensor output

A/D conversion select
(® High-speed

@ AVCCD

® AVSS0

Self diagnosis setting

Mode

Enable AD conversion end interrupt (S12ADI0)

Priority Level 13 (highest) ~
ANDO2 ANOD3 ANDD4
ANOOT AND16 ANOTY
AND20 AND2T

Internal reference veltage

(O Low-current

High-Potential reference voltage setting

O VREFHD

Low-Potential reference voltage setting

(O VREFLO

Unused ~

o

Disconnection detection assist setting

Charge setting

Data registers setting

Data placement

Autematic clearing
Addition/Average mode select
Addition count

Data storage buffer setting
(®) Disable

Window function setting
(®) Disable

Window A/B operation setting

[[]Enable comparison window A

Unused ~
2ADCLE
Right-alignment -
Disable automatic clearing ~
Addition mode ~
1-time ~
() Enable
(O Enable

[[JEnable comparison window B

Window A comparisen conditien matched OR window B comparison condition matched

Figure 4-38 Config_S12AD0 setting (1)
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A/D comparison A setting

Reference data Ofar comparison

Reference data 1for cormparison
Use comparator for ANODO
Use comparator for AMNOOT

A

Use comparator for ANDOZ
Use comparator for AN003
Use comparator for ANDIY
Use comparator for ANOOS
Use comparator for AND0E
Use comparator for ANOOT
Use comparator for AND16
Use comparator for ANO17
Use comparator for AND18
Use comparator for ANOTS

Use comparator for AN020

Use comparator for AND27

Use comparator for Temperature sensor cutput

Use comparator for Intemal reference voltage

A/D comparison B setting
Reference data Ofor cormparison
Reference data 1for cormparison

Comparison B channel

Input sampling time setting
AMNODO/Self-diagnosis
AN

AMNOD2

ANODE

AN

AMNODS

AMNODE

ANQDT

ANDTE-AMOZ0, ANOZT
Ternperature sensor output

Internal reference voltage

Event link control setting

ELC scan end event generation condition

Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 = A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 = A/D-converted value

Reference data 0 > A/D-converted value

Unused

Reference data 0 > A/D-converted value

0.407 | s
0.407 fus)
0.407 fus)
0.407 fus)
0.407 fus)
0.407 )
0.407 fus)
0.407 fus)
0407 s
E] (ps)
3 (ns)

(Total conversion time: 1.074ps)

On completion of all scans

(Actuzl value:
(Actuzl value:
(Actual value:
(Actual value:
(Actuzl value:
(Actuzl value:
(Actuzl value:
(Actuzl value:
(Actual value:
(Actual value:

(Actuzl value:

0.407)
0.407)
0.407)
0.407)
0.407)
0.407)
0.407)
0.407)
0407
2.500)
25000

Figure 4-39 Config_S12AD0 setting (2)
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4.6 The ‘Pins’ tabbed page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed using the Pins page.

{8} SC_Tutorial.scfg 53

Pin configuration

Hardware Resource = 18 =2
Type filter text
A -

E Clock generator
{7, Clock frequency accuracy measurement ¢
‘,!‘: Operating mode control
‘,!‘: System control
‘,!‘: On-chip emulator
4 Interrupt controller unit
~ 4 Multi-function timer pulse unit 2
MTUQ
MTU1
MTUZ
MTU3
W MTU4
&% Port output enable 2
~ &% 16-bit timer pulse unit
i TPUO
TPU1
TPUZ
TPUZ
TPU4
i TPUS
v {7 8-bit timer
' TMRO
i TMRI
i TMR2
Wi TMR3
w ﬂ-tg Serial communications interface
Wi 5CIH

Pin Function Pin Number

Overview |Board | Clocks | Components Interrupts

Figure 4-40 The ‘Pins’ tabbed page

4.6.1 Change pin assignment of a software component

I

To change the pin assignment of a software component in the Pin Function list, click
show by Software Components.

to change view to

ﬁj *5C_Tutorialscfg 23

Pin configuration

Hardware Resource = laz

Type filter text

Figure 4-41 Change view to show by Hardware Resource
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Select the Config_ICU of Software Components. In the Pin Function list -> Assignment column, change the
pin assignment IRQO to P30, IRQ1 to P31. Ensure the ‘Enable’ tick box of IRQO and IRQ1 are checked, as
shown in Figure 4-42.

Software Components =] /3, &% PinFunction ~l | t” Jg‘_'” B3
Type filter text type filter text All ~
> i'!: r_bsp Enabled  Function Assignment Pin Number Direction Remarks

b
obep ; IRCO J_P30/MTIOCAB/TMRIZ/POES#/RTCICO/RXD1/SMIS.. | # A2 |
v Compare Match Timer = . .
". Confia CMTO IRQ1 4 _PI/MTIOCAD/ TMCI2/RTCICT/CTS1#/RTS1#/551%... | # B4 |
onfi
woc f'g_CMT1 O IRC4 # Mot assigned # Mot assigned  Mone
onfi
W C f'g_CMTE O IRQS # Mot assigned # Mot assigned Mone
onfi
9- O IRQE # Mot assigned # Mot assigned Mone
v ﬁ'ﬂ Interrupt Controller . .
= Confia ICU O IRQ7 # Mot assigned # Mot assigned  MNone
onfi
= ﬁ;f\‘jrts = O MNMI # Mot assigned # Mot assigned Mone
& Config_PORT
~ M 5CI/SCIF Asynchronous Mode
& Config_5CI3
v ﬁ; 5PI Clock Synchronous Mode
& Config_5CI12
~ & Single Scan Mode 512AD
& Config_5124D0
£ >
Pin Function Pin Number

Figure 4-42 Configure pin assignment - Config_ICU

Select the Config_SCI8 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD8 and TXD8 are checked and Assignment column of RXD8 is PC6 and TXD8 is PC7
as shown in Figure 4-43.

Software Components £ |4, &2 FPinFunction o | t” _;l—:” L1

Type filter text type filter text All -

™ i'i'- r_bsp Enabled  Function Assignment Pin Number Direction Remarks

CTsSez # Mot assigned # Mot assigned Mone
RTS8% 4 Mot assigned # Mot assigned Mone
RXD2 L7 _PCE/MTIOCIC/ MTCLEA/TMCI2RYDE/SMISOE/SS. .| # F2 |
SCKa 4 Mot assigned # Mot assigned Mone
TXDE L7 _PCT/UB/MTIOCIA/MTCLKE/ TMOTXDS/SMOSIS...] # F1 0

' r_bsp
v ‘-4'; Compare Match Timer
w' Config_CMTO
w' Config_CMT1
w' Config_CMT2
v ﬁ; Interrupt Controller
& Config_ICU
v ‘-5'; PEr‘ts
& Config_PORT
v ﬁ; SCI/SCIF Asynchronous Mode
& Config_5CI8
v ‘-5; 5PI Clock Synchronous Mode
& Config_5CI12
v /& Single Scan Mode 512AD
& Config_S12AD0

[ ] & ]

Pin Function = Pin Number

Figure 4-43 Configure pin assignment - Config_SCI8
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Select the Config_SCI12 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK12 and SMOSI12 are checked and Assignment column of SCK12 is PEO, SMOSI12 is

PE1 as shown in Figure 4-44.

Software Components =] laz g,%

Type filter text

v ‘H'; r_bsp
' r_bsp

v ﬁ; Compare Match Timer
w' Config_CMTO
w' Config_CMT1
w' Config_CMT2

v ﬁ; Interrupt Controller
& Config_ICU

v ‘H'; Ports
& Config_PORT

W ‘.-‘.-._ SCI/SCIF Asynchronous Mode
& Config_5CIa

~v %, 5Pl Clock Synchronous Mode
@& Config_SCI2

~ % Single Scan Mode S12AD
& Config_5124D0

Pin Function Pin Number

Pin Function £ | t” Jf” 2 ey
type filter text All ~
Enabled  Function Assignment Pin Number Direction Remarks
scK12 [FPED/SCKIz/AND G ] 7 6o 10
[l SMISO12 # Mot assigned # Mot assigned Mone
sMmosi12 L#_PE1/MTIOCAC/ TXD12/THDX12/5I0X12/SMO512/5..] # 19 10
O 5512# # Mot assigned # Mot assigned Mone
£ >

Figure 4-44 Configure pin assignment - Config_SCI12

Select the Config_S12AD0 of software components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of AN0O0O, AVCCO and AVSSO0 are checked and Assignment column of ANOOO is P40 as

shown in Figure 4-45.

Software Components = 12, =

Type filter text

w ‘-5'; r_bsp
w' r_bsp
v ﬁ; Compare Match Timer
w' Config_CMTO
w' Config_CMT1
w' Config_CMT2
W ‘.-‘.-._ Interrupt Controller
& Config_ICU
v ‘.-‘.-._ Ports
& Config_PORT
W ,-5'-_ SCI/SCIF Asynchronous Mode
& Config SCI3
W ,-5'-_ 5PI Clock Synchronous Mode
@& Config SC12
v /% Single Scan Mode 512AD
& Config_512AD0

Pin Function = Pin Number

Pin Function

type filter text
Enabled  Function Assignment

[l ADTRGOZ # Mot assigned
ANDDD L7 _P40/ANODD
O ANOOT # Mot assigned
O ANDDZ # Mot assigned
[ AN0O3 # Mot assigned
[ ANOO4 # Mot assigned
[ ANOO3 # Mot assigned
[ ANO0G # Mot assigned
O ANOOT # Mot assigned
O ANO16 # Mot assigned
O ANOTT # Mot assigned
O ANO18 # Mot assigned
O ANO19 # Mot assigned
O AN020 # Mot assigned
O ANOZT # Mot assigned
AVCCD [ avcco

AVSS0 [aEse

[ VREFHD # Mot assigned
[ WREFLD # Mot assigned

LU (=T
All ~

Pin Number Direction Remarks
Mot assigned  Mone
c9 |

Mot assigned  Mone
Mot assigned  Mone
Mot assigned  Mone
Mot assigned  MNone
Mot assigned  MNone
Mot assigned  MNone
Mot assigned  MNone
Mot assigned  Mone
Mot assigned  Mone
Mot assigned  Mone
Mot assigned  Mone
Mot assigned  Mone
Mot assigned  Mone
B10 |

AT0 |

Mot assigned  Mone

LR T B R R R R A TR T R R R R B R B

Mot assigned  Mone

Figure 4-45 Configure pin assignment - Config_S12AD0
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Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘felGenerate Code’ at location of Figure 4-46.

{8 *SC_Tutorialscfg 52 = 0

Pin configuration

Figure 4-46 Generate Code Button

The Console pane should report ‘Code generation is successful’, as shown Figure 4-47 below.

B Console i3 '-Ext.‘ﬂf_‘“'avi:ﬁ'mﬁ
Smart Configurater Output
MB4BBBBRL: File generated:s
Me488@81: File generated:s
Me488@81: File generated:s
Me488@81: File generated:s
Me488@81: File generated:s
MB4aBR@A1: File generated:s
MB4aBR@A1: File generated:s
MB4aBR@A1: File generated:s
MB4aBR@A1: File generated:s
MB4EBRERL: File generated:s

\Config SCI12\Config SCI12.h A
“Config SCI12\Config SCI12.c

‘“Config SCI12\Config SCI12 user.c

WConfig 512AD8\Config S12AD8.h

MZConfig 512ADB\Config S12AD@.c

‘Config 5128D@\Config S12AD8 user.c

‘\general\r cg macrodriver.h

‘\general\r cg userdefine.h

‘general\r smc _entry.h

‘jgenerall

cg hardware setup.c

MB4EBRERL: File generated:s ‘general\r cg cmt.h
MB4EBRERL: File generated:s ‘general\r cg icu.h
Me4eBReel: File generated:s ‘general\r cg port.h
Me4eBReel: File generated:s ‘general\r cg slZad.h
Me4eBReel: File generated:s ‘jgeneral\r cg sci.h

Me4eBReel: File generated:s
Meseaeel2: File generated:s
Meseaeel2: File generated:s ‘r_pincfgiPin.c

MeceReea2: File generated:s ‘jgeneral\r smc interrupt.c
Meeeaeee2: File generated:srcismc gen‘generallr smc interrupt.h
Meeeeeee2: Code generation is successful

Ma3e00084: File modified:srch\smc gen’r confighr bsp config.h

Mgeneral\r cg rspi.h
A pincfghPin.h

Figure 4-47 Smart Configurator console

4.7 Building the Project

The project template created by Smart Configurator can now be built. In the Project Explorer pane expand the
‘src’ folder then smc_gen folder.

[ Project Bxplorer 33 =% Y= 8
v =5 5C_Tutorial
i Includes
w2 osre
~ [= smc_gen

= Config_CMTO
= Config_CMT1
= Config_CMT2
= Config_ICU
= Config_PORT
= Config_S12AD0
(2= Config_SC12
= Config_5CI8
= general
= r_bsp
= r_config
= r_pincfg
[¢ SC_Tutorial.c
[= trash
=| SC_Tutorial HardwareDebug.launch

{8 5C_Tutorial.scfg

Figure 4-48 Generated folder structure

FE

Switch back to the ‘C/C++’ perspective using the button on the top right of the e? studio workspace.

Select SC_Tutorial in the Project Explorer pane, then use ‘Build Project’ from the ‘Project’ menu or the
button to build the tutorial. The project will build with no errors.
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5. User Code Integration

In this section, the remaining application code is added to the project. Source files found in the RSSK Web
Installer are copied into the workspace and the user is directed to add code in the user areas of the code
generator files.

Code must be inserted into the user code area within many Smart Configurator-generated files in this project,
these user code areas are delimited by comments as follows:

/* Start user code for xxxxx . Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user subsequently needs to use Smart Configurator to regenerate any of the Smart
Configurator-generated code.

5.1 Project Settings

e Change the optimization level of the O FrojectBplore 56 2% 7= 8
build configuration 'HardwareDebug' M
before building the project. With the v @8 s Openin New Window

SC_Tutorial project selected, right- v B;‘&i::.g B Copy Ctrl+C
click and select [Properties], or use & Confiy ;‘; CD‘I‘et
the shortcut keys [Alt] + [Enter] to & ] souee ,
open the Properties window. & Config.  Move..

(= Config_ Rename... F2

== Config_

&= Config_ i Import..

(= general 5 Export..

= r_bsp

(= r_config Build Project

&= r_pincfg Clean Project

|| SC_Tutorial ; Refresh F5
(= trash

Close Project
=| SC_Tutorial Ha

- se lJ rojects
&b SC_Tutorial.scfi Close Unrelated Projects

#7 Run C/C++ Code Analysis
B System Explorer
B Command Prompt
Configure >
Properties Alt+Enter
e Navigate to ‘C/C++ Build -> Settings | settings G
->Compiler -> Optimization.
Configuration: | HardwareDebug [ Active ] ~ | | Manage Cenfigurations...
e Select 'Level 0: Do not perform - . sesontout
Optlmlzatlon from the Optlmlzatlon i3 Tool Settings  Toolchain Device Build Steps Build Artifact [u) Binary Parsers 3 Error Parsers

level pull-down.

w B Common Optimization level

~ ( Source
(5 Advanced
& Object
(2 List
~ (2 Optimization
(2 Advanced

Perform loop optimization

Performs inline expansion automatically

Level 2: Performs whole module optimization

100

® e
s [] Outputs additional information for inte fiSa iAol detie el )
= PIC/PID Level 1: Perform partial optimization
(# Miscellaneous Optimization type Level 2: Performs whole module optimization
v 5 Compiler Level max: Perform all applicable optimizations

Depends on the optimization option ~

2 Output
e Press the ‘Apply and Close’ button to
close Properties window. Cancel
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5.2 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-ascii.c
-ascii.h
-r_okaya_lcd.c
-r_okaya_lcd.h
Copy these files in to the src folder below the workspace. These files will be automatically added to the
project as shown in Figure 5-1.

™ Project Explorer &3 9% ¥ = O
v =% SC_Tutorial [HardwareDebug]
! Includes
w [ src
&= smc_gen
[ asciic
ascii.h
[ r_okaya_led.c
r_okaya_led.h
[ sC_Tutorial.c

Figure 5-1 Adding files to the project
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In the e? studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’ by
double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for macro define. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src’ folder and open the file ‘SC_Tutorial.c’ by double-clicking on it.
Add header files near the declaration ‘#include r_smc_entry.h’.

#include "r smc entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display (0, (uint8 t *)" RSSKRX23W ");

R LCD Display(l, (uint8 t *)" Tutorial ");

R LCD Display(2, (uint8 t *)" Press Any Switch ");
while (10U)

{

}

Indentation is lost when the code described in this manual is pasted into the e? studio source file. Also check that
the pasted code is correct.
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5.21 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in §4.5.6. In
the e2 studio Project Tree, expand the ‘src\smc_gen\Config_SCI12’ folder and open the file ‘Config_SCI12.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI12 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */
Now, open the Config_SCI12_user.c file and insert the following code in the user area for global:
/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t gs scil2 txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI12:

static void r Config SCI12 callback transmitend(void)
{
/* Start user code for r Config SCI12 callback transmitend. Do not edit comment generated here */

gs_scil2 txdone = TRUE;

/* End user code. Do not edit comment generated here */

}

Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

R e

* Function Name: R _SCI12 SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD_ARGERROR

*******************************************************************************/
MD STATUS R_SCI12 SPIMasterTransmit (uint8 t * const tx buf,
const uintl6 t tx num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
gs_scil2 txdone = FALSE;

/* Send the data using the API */
status = R Config SCI12 SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == gs_scil2 txdone)
{
/* Wait */
}

return (status);

}

KKK KKKk K K K K K K K R K R kK K R K K K R R R K K R R R K R R R K K K ok ok K R R R kK K R Rk ko kR ok Rk kK

* End of function R SCI12 SPIMasterTransmit
khkhkkhhkkhhhkhkhhkhkkhhhkhhkhkhkhhhkhhkhkhkhkh kb kb bk hkhhk bk bk hkhh bk bk hkhkhkhhkhkhkhkhkhkhkhkhhkhkhkhkrhkhkhkhkhkhkhkhhkhkxkhx

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.2.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in §4.5.2. Open the file
‘src\smc_gen\Config_ CMTO0\Config_ CMTO0.h’ and insert the following code in the user area for function at the
end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ CMTO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t gs one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config CMTO_cmiO_interrupt function and insert the following line in the user code area:

static void r Config CMTO cmiO_ interrupt (void)
{
/* Start user code for r Config CMTO cmiO_interrupt. Do not edit comment generated here */

gs_one ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

[ KKk ok ok ok ok kK A A K K K Kk ok ok ok ok ok ok R A A A R K K Kk ko k ok ok ok R A A A R A K Kk ko ok ok ok ok ok kA A AR K K Kk ok kR ok ok ok ok ok

* Function Name: R_CMT MsDelay

* Description : Uses CMTO to wait for a specified number of milliseconds

* Arguments : uintl6 t millisecs, number of milliseconds to wait

* Return Value : None
*******************************************************************************/
void R _CMT MsDelay (const uintlé t millisec)

{

uintlé_t ms_count = 0;

do
{
R Config CMTO_ Start();
while (FALSE == gs_one ms_delay complete)
{
/* Wait */
}
R Config CMTO Stop();
gs_one _ms_delay complete = FALSE;
ms_count++;
} while (ms_count < millisec);

}

/*******************************************************************************

End of function R CMT MsDelay
*******************************************************************************/
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5.3 Additional include paths
Before the project can be built the compiler needs some additional include paths added. Select the
SC_Tutorial project in the Project Explorer pane. Right click in the Project Explorer window and select

[Properties]. Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the £ button as shown in
Figure 5-2.

e’ Properties for SC_Tuterial

type filter text Settings =1 4 - -
Resource
w CfC++ Build ~
Settings Configuration: |HardwareDebug [ Active ] ~ | | Manage Configurations...

Tool Chain Editor
C/C++ General

Run/Debug Settings i Tool Settings Toolchain  Device A Build Steps Build Artifact Binary Parsers € Error Parsers
~ & Common Include file directories |D & @
& cpy . . =
= pIC/PID S{workspace,loc:fS{ProJ_Name}fsr(.f;m(,gen,-fr,bsp}_ ~
= - "S{workspace_loc:/${ProjName}/src/smc_gen/r_config}"
(# Miscellaneous "$lworkspace_loc:/${ProjNamel/src/sme_gen/Config_CMTO}"
w 3 Compiler "Sworkspace_loc:/${ProjMName}/src/sme_gen/Config_CMT1}"
v @ Source "S{workspace_loc/${ProjNamel/src/sme_gen/Config_CMT2}"

"S{workspace_loc/${ProjMame}/src/smec_gen/Config_ICU}"

@ Advanced | !
"S{workspace_loc:/${ProjMName}/src/smec_gen/Config_PORT}"

% O_bJECt "Sworkspace_loc:/${ProjMame}/src/smec_gen/Config_5CI18}"
E?’ List "S{workspace_loc/S{ProjMName}/src/sme_gen/Config_SCI12}"
v @ Optimization "S{workspace_loc/${ProjMamel/src/sme_gen/Config_512AD0}"
@ Advanced "S{workspace_loc:/5{ProjMName}/src/smc_gen/general}”
@ Output "Sworkspace_loc:/${ProjName)/src/smc_gen/r_pincfg}" v

@ MISRA C Rule Check
(2 Miscellaneous

Figure 5-2 Adding additional search paths

Pre-include files &

In the ‘Add directory path’ dialog, click the ‘Workspace...’ button and in the ‘Folder selection’ dialog browse to
the ‘SC_Tutorial/src’ folder and click ‘OK’. e? studio formats the path as shown in Figure 5-3 below.

e? Add directory path

Directory:

‘ "8{workspace_loc:/${ProjName}/src}

oK Cancel File system...
Figure 5-3 Adding workspace search path

Close the property by clicking the 'Apply and Close' button shown in Figure 5-2, and when the 'Settings'
dialog shown in Figure 5-4 is appeared, click 'Yes' to finish the setting.

I-" -~ '\.I Changes made will not be reflected in the index until it is rebuilt. Do you wish to
L - 4 rebuild it now?

Yes No

Figure 5-4 Settings dialog

-

Select ‘Build Project’ from the ‘Project’ menu, or use the % button. e? studio will build the project with no
errors.

The project may now be run using the debugger as described in §6. The program will display ‘RSSKRX23W
Tutorial Press Any Switch’ on three lines in the LCD display.
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54 Switch Code Integration

API functions for user switch control are provided with the RSSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-rsskrx23wdef.h
-r_rssk_switch.c
-r_rssk_switch.h
Copy these files in to the src folder below the workspace.

The switch code uses interrupt code in the files Config_ICU.h, Config_ICU.c and Config_ICU_user.c and timer
code in the files Config_ CMT1.h, Config_CMT1.c, Config_CMT1_user.c, Config_CMT2.h, Config_ CMT2.c and
Config_ CMT2_user.c as described in §4.5.2. and §4.5.3 It is necessary to provide additional user code in
these files to implement the switch press/release detection and de-bouncing required by the API functions in
r_rssk_switch.c.

5.4.1 Interrupt Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_ICU’ folder and open the file ‘Config_ICU.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */

uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no);

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);

void R _ICU IRQSetRisingEdge (const uint8 t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */
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Now, open the Config_ICU.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* Function Name: R _ICU IRQIsFallingEdge

Description : This function returns 1 if the specified ICU IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8 t irqg no

* Return Value : 1 if falling edge triggered, 0 if not

*******************************************************************************/
uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no)
{ uint8 t falling edge trig = 0x0;

if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE_FALLING)

{ falling edge trig = 1;

}

return (falling edge trig);

VAREEEEEEE SRR EEE RSt R R Rt EEE Rt EE Rt

* End of function R _ICU IRQIsFallingEdge

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k******************************/

VARREEEEEE SRR EEE SRR R R EEEEE R R Rt

* Function Name: R ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if

* clearing

* Return Value : None
*******************************************************************************/

void R ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set_f edge)
{
ICU.IRQCR[irg no] .BYTE |= 04 ICU IRQ EDGE FALLING;
}
else
{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;
}
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R ICU IRQSetFallingEdge

LR EEEE RS SRR EEE AR EE R R EEE R R Rt

VARREEEEEE S SRR R EE S AR EE R R EE Rt EE Rt

* Function Name: R_ICU_IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing

* Return Value : None
*******************************************************************************/

void R _ICU IRQSetRisingEdge (const uint8 t irg no, const uint8 t set r edge)
{
if (1 == set r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE RISING;

}

else

{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R ICU IRQSetRisingEdge

LR EEEE RS EAEEEEE R EEE R EE R EEE Rt
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Open the Config_ICU_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rssk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg1_interrupt:

/* Start user code for r Config ICU irgl interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R_SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irq0_interrupt:

/* Start user code for r Config ICU irg0 interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */

5.4.2 De-bounce Timer Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMT1 folder and open the
‘Config_CMT1_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rssk switch.h"

/* End user code. Do not edit comment generated here */

In the Config_ CMT1_user.c’ file, insert the following code in the user code area inside the function
r_Config_ CMT1_cmi1_interrupt:

/* Start user code for r Config CMT1 cmil interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT1 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMT2' folder and open the file
‘Config_ CMT2_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rssk switch.h"

/* End user code. Do not edit comment generated here */
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Open the Config_ CMT2_user.c file and insert the following code in the user code area inside the function
r_Config_ CMT2_cmi2_interrupt:

/* Start user code for r Config CMT2 cmi2 interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT2 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

543 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In this code, we also perform software triggered A/D conversion from the user switches
SW1 and SW2, by reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the e2 studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’.
Insert the following code the user code area, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */
extern volatile uint8 t g adc_trigger;

/* End user code. Do not edit comment generated here */

In the e2 studio Project Tree, expand the ‘src’ folder and Open the file ‘SC_Tutorial.c’ and add the highlighted
code, resulting in the code shown below:

#include "r smc entry.h"
#include "r lcd.h"
#include rdefine.h"
#include g S12AD0.h"
#include "r rssk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6é t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the
code shown below:

void main (void)

{

}

/* Initialize the switch module */
R _SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R LCD Init ();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)" RSSKRX23W ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0_Start();

while (10U)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
else
{
/* do nothing */
}

Then add the definition for the switch call-back, get adc and lcd_display_adc functions below the main
function, as shown below:

/******************************************************************************

* Function Name : cb switch press

* Description : Switch press callback function. Sets g adc trigger flag.
* Argument : none

* Return value : none

******************************************************************************/

static void cb switch press (void)

{

}

/* Check if switch 1 or 2 was pressed */
if (g _switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))
{

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch flag = 0x0;

/******************************************************************************

* End of function cb switch press
KAk hkhhkhkhkhkhkhkhkhk bk hk ok hk ko hhk ok hk ok hhk ok hk ko hhk ok hk ko hhk ok hk ko hhk ok ko hkk ok h ko bk khkhhkhkkhkhkhkhhkhkhhkhkhkhkhkhkhkkkhkkhkkkkk
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/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

Function Name : get adc

* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.

* Argument : none

* Return value : uintl6 t adc value

******************************************************************************/
static uintlé t get adc (void)

/* A variable to retrieve the adc result */
uintlé t adc result = 0;

/* Start a conversion */
R Config S12AD0 Start();

/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)
{
/* Wait */
nop () ;
}

/* Stop conversion */
R Config S12AD0 Stop();

/* Clear ADC flag */
g_adc_complete = FALSE;

R _Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

return (adc_result);

}

/******************************************************************************
* End of function get adc

******************************************************************************/
/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

******************************************************************************/
static void lcd display adc (const uintl6é_t adc_result)
{

/* Declare a temporary variable */

uint8 t a;

/* Declare temporary character string */
char lcd buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (char) ((a < 0x0A) 2 (a + 0x30) : (a + 0x37));

a = (uint8_t) ((adc_result & 0x00F0) >> 4);

lcd buffer[7] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t) (adc_result & 0xO000F);

lcd buffer[8] = (char) ((a < 0x0A) 2 (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd buffer */
R_LCD Display(3, (uint8 t *)lcd buffer);

}

/******************************************************************************

* End of function lcd display adc

******************************************************************************/
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In the e? studio Project Tree, expand the ‘src\smc_gen\Config  S12AD0’ folder and open the file
‘Config_S12ADO0.h’ by double-clicking on it. Insert the following code in the user code area for function,
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc_complete;

/* End user code. Do not edit comment generated here */

Open the file Config_S12ADO0_user.c and insert the following code in the user code area for global, resulting in
the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_S12ADO0 _interrupt function, resulting in the
code shown below:

static void r_Config S12AD0_interrupt (void)
{

/* Start user code for r Config S12AD0 interrupt. Do not edit comment generated here */
g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

4

Select ‘Build Project’ from the ‘Project’ menu, or use the "® * button. e? studio will build the project with no

errors.

The project may now be run using the debugger as described in §6. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the Tutorial to add the UART user code.

5.5 Debug Code Integration

API functions for trace debugging via the RSSK serial port are provided with the RSSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Check that the following files are in the
src folder:

-r_rssk_debug.c

-r_rssk_debug.h
Copy these files in to the src folder below the workspace.

In the r_rssk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL DEBUG WRITE (R _SCI8 AsyncTransmit)

This macro is referenced in the r_rssk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.
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5.6 UART Code Integration

5.6.1 SCI Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_SCI8’ folder and open the file ‘Config_SCI8.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R _SCI8 AsyncTransmit (uint8 t * const tx buf, const uintlé t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI8_user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t gs sci8 txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI8_callback_transmitend function:

static void r Config SCI8 callback transmitend (void)
{
/* Start user code for r Config SCI8 callback transmitend. Do not edit comment generated here */

gs_sci8 txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area inside the
r_Config_SCI8_callback_receiveend function:

static void

{

/* Start

r Config SCI8 callback receiveend(void)

/* Check the contents of g rx char */

if (('c'
{

== g _rx char) || ('C' == g _rx char))

g_adc_trigger = TRUE;

}

/* Set up SCI8 receive buffer and callback function again */
R Config SCI8 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/‘k‘k‘k‘k‘k‘k****************************************‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* Function Name: R SCI8 AsyncTransmit

* Description : This function sends SCI8 data and waits for the transmit end flag.
* Arguments tx buf -

* transfer buffer pointer

* tx_num -

* buffer size

* Return Value : status -

*

MD OK or MD ARGERROR

***********************:********:********************‘k‘k************************/

MD_STATUS R_SCI8 AsyncTransmit (uint8 t * const tx buf, const uintl6_t tx_ num)

{

MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
gs_sci8 txdone = FALSE;

/* Send

the data using the API */

status = R Config SCI8 Serial Send(tx buf, tx num);

/* Wait

for the transmit end flag */

while (FALSE == gs_sci8_ txdone)

{

/* Wait */

}

return

}

(status) ;

/*******************************************************************************

* End of function R SCI8 AsyncTransmit

KKK KKK KKK KKK KKK KK KK K K R K K K K R R R K R R K R R R K R R R R R R KRR K K R R A A A K K R R A A A K KR R A AR KKK kA AR Kk kK /

user code for r Config SCI8 callback receiveend. Do not edit comment generated here */
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5.6.2 Main UART code

Open the file ‘SC_Tutorial.c’. Add the following declaration to near the top of the file:

#include "r smc _entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rssk switch.h"
#include "r rssk debug.h"
#include "Config SCI8.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t gs_adc count, const uintlé t adc result);

/* Variable to store the A/D conversion count for user display */
static uint8 t gs_adc count = 0;

Add the following highlighted code in the main function:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SWl1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)" RSSKRX23W ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R _Config S12AD0_Start();

/* Set up SCI8 receive buffer and callback function */
R Config SCI8 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI8 operations */
R Config SCI8 Start():;

while (10)
{

uintlé_t adc_ result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the gs adc count */
if (16 == (++gs_adc_count))
{

gs_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(gs_adc_count, adc_result);
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/* Reset the flag */
g_adc_trigger = FALSE;
}

else

{
/* do nothing */
}

Then, add the following function definition in the end of the file:

J KKk Kk ok kKA KA KKK KKk ok kkk kKA A KA A KKKk k ok h ok kA A KA K E &K Kk ok ko h ok ok kA XA A A& K&Kk ok kkokokokox

* Function Name : uart display adc

* Description : Converts adc result to a string and sends it to the UART.
* Argument : uint8 t : gs_adc_count

* uintlé t: adc result

* Return value : none

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k*************‘k‘k‘k‘k‘k‘k***********************/

static void uart display adc (const uint8 t gs adc count, const uintlé6_t adc result)

{

/* Declare a temporary variable */
char a;

/* Declare temporary character string */
static char uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char) (gs_adc_count & 0x000F);

uart buffer[4] = (char) ((a < 0xO0A) ? (a + 0x30) : (a + 0x37));
a = (char) ((adc_result & 0x0F00) >> 8);

uart buffer[14] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char) ((adc_result & 0x00F0) >> 4);

uart buffer[15] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char) (adc_result & 0x000F);

uart buffer[16] = (char) ((a < 0x0A) 2 (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R DEBUG Print (uart buffer);

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k****************************************************

* End of function uart display adc
************************‘k*************************‘k‘k*‘k‘k***********************/

Select ‘Build Project’ from the ‘Project’ menu. e? studio will build the project with no errors.

The project may now be run using the debugger as described in §6. Connect the RSSK USBCNO port to a
USB port on a PC. If this is the first time the RSSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &

LPT)" as 'RSSK USB Serial Port (COMx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI8 (Baudrate:

19200, Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None).

When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC

terminal program via the SCI8.
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5.7 LED Code Integration

Open the file ‘SC_Tutorial.c’. Add the following declaration to the near the top of the file:

#include "r smc entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rssk switch.h"
#include "r rssk debug.h"
#include "Config SCI8.h"
#include "rsskrx23wdef.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintlé_t adc_result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t gs adc count, const uintl6 t adc result);

/* Variable to store the A/D conversion count for user display */
static uint8_t gs_adc_count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code in the main function:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display (0, (uint8 t *)" RSSKRX23W ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI8 receive buffer and callback function */
R Config SCI8 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI8 operations */
R Config SCI8 Start();
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while (10U)
{

uintlé t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the gs_adc_count and display using the LEDs */
if (16 == (++gs_adc_count))
{
gs_adc_count = 0;
}
led display count (gs_adc_ count);

/* Send the result to the UART */
uart _display adc(gs_adc_count, adc_result);
/* Reset the flag */
g _adc_trigger = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition at the end of the file:

/******************************************************************************

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDSO0-3
* Argument : uint8 t count

* Return value : none

******************************************************************************/

static void led display count (const uint8 t count)
{

/* Set LEDs according to lower nibble of count parameter */

LEDO = (uint8 t) ((count & 0x01) ? LED ON : LED OFF);
LEDL = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8 t) ((count & 0x04) 2 LED ON : LED OFF);
LED3 = (uint8 t) ((count & 0x08) 2 LED ON : LED OFF);

}

/******************************************************************************

* End of function led display count
******************************************************************************/

|

Select ‘Build Project’ from the ‘Project’ menu, or use the
errors.

" button. e? studio will build the project with no

The project may now be run using the debugger as described in §6. The code will perform the same but now

the LEDs will display the gs_adc_count in binary form.
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6. Debugging the Project

In the Project Explorer pane, ensure that the ‘SC_Tutorial’ project is selected. To enter the debug
configurations, click upon the arrow next to the debug button - #L7l and select ‘Debug Configuration’.

e’ Debug Configurations

Create, manage, and run configurations
- )
= X | H MName: |SC_Tutor\a\ HardwareDebug
type filter text [£] Main . %5 Debugger| = Startup| [] Commen Eﬁ/ Source
[€] C/C++ Application o e
[€] C/C++ Remote Application
=" EASE Seript |SC_Tut0r|a\ Browse...
[£] GDB Harcware Debugging C/C++ Application:
*| GDB Simulator Debugging (RHE50]
imulator Debugging ( ) |HardwareDebug_a'SC,TutoriaI.x
Java Applet
lava Application Variables... Search Project... Browse...
L Launch Group - . .
Build (if required) before launching
= Launch Group (Deprecated)
Remote Java Application Build Configuration: | Select Automatically i
W Renesas GDB Hardware Debugging i i
&) SC_Tutorial HardwareDebug () Enable auto build (C) Disable auto build
Renesas Simulator Debugging (RX, RL7E) (®) Use workspace settings Configure Workspace Settings...
Revert Apply
Filter matched 13 of 15 iterns

Figure 6-1 Debug Configurations

In order to execute the project, it is necessary to change the following settings in ‘Renesas GDB Hardware
Debugging’ -> ‘SC_Tutorial HardwareDebug’ -> ‘Debugger’ -> ‘Connection Settings’.

Ensure that in ‘Connection Settings’ tab that the ‘Power Target From The Emulator (MAX 200mA)’ is set to
Yes, and ‘Main Clock Source’ is set to HOCO.

For more information on powering the RSSKRX23W please refer to the User’'s Manual.

Mame: | SC_Tutornial HardwareDebug
Main | %5 Debugger . [ Startup| [C] Common . Source

Debug hardware: | E2 Lite (RX) ~ | Target Device: | RSF523W8

GDB Settings Debug Tool Settings

v Clock ~
Main Clock Source ]
Extal Frequency[MHz] 2.0000
Permit Clock Source Change On Writing Internal Fl Yes v

~ Connection with Target Board
Emulator (Auto)
Connection Type Fine
ITag Cleck Frequency[MHz] 6.00
Fine Baud Rate[Mbps] 1.50 ]
Hot Plug Mo

v Power
Power Target From The Emulater (MAX 200mA) ]
Supply Voltage[V] 3.3

Figure 6-2 Connection Settings

When the setting is complete, press the 'Apply' button followed by the "Close" button to close the debug
configuration window.
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Connect the E2 Lite to the PC and the RSSK E1/E2 Lite connector. Connect the Pmod LCD to the PMOD2
connector.
In the Project Explorer pane, ensure that the ‘SC_Tutorial’ project is selected. To debug the project, click the

button. The dialog shown in Figure 6-4 will be displayed.

e? Confirm Perspective Switch

3 1 This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It incorporates
views for displaying the debug stack, variables and breakpoint management.

Do you want to open this perspective now?

Yes No

Figure 6-3 Perspective Switch Dialog

Click ‘Remember my decision’ to skip this dialog later. Click ‘Yes’ to confirm that the debug window
perspective will be used. The debugger will start up and the code will stop at the Smart Configurator function
‘PowerOn_Reset PC’ as shown in Figure 6-5.

e? Workspace - 5C_Tutorial/src/smc_gen/r_bsp/mecuy/all/resetprg.c - & studio

File Edit Source Refactor Mavigate Search Project Renesas Views Run  Window Help

5 Debug ~ | | E¥] SC_Tutorial HardwareDebug v A
Y- RT R R R R
45 Debug 13 | i% | @
w SC_Tutorial HardwareDebug [Renesas GDB Hardware Debugging]
v 2 SC_Tutorialx [1] [cores: 0]
w o Thread #1 1 (single core) [core: 0] (Suspended : Signal : SIGTRAP: Trace/breakpoint trap)
= PowerON_Reset PC() at resetprg.c:164 Oxfff21dc1
st ne-elf-gdb -ne-force-v2 (7.8.2)
s Renesas GDB server (Host)

resstprg.c 52
B71c4 fffaldcl - [R_BSP_POR_FUNCTION(R_BSP_STARTUP FUNCTION)

165 1

166 /* stack pointers are setup prior to calling this function - see
167

163 = /* You can use auto variables in this funcign but such variables
169 * will be unavailable after you change the stack from the I sta
17@

171 = /* The bss sections have not been cleared and the data sections
172 * and constructors of (44 objects have not been executed until
173 - #if defined(__GNUC__)

174 - #if BSP_CFG_USER_STACK_ENABLE == 1

175 INTERNAL_NOT_USED(ustack area);

176 #endif

177 INTERNAL_NOT_USED(istack area);

178 #endif

179

180 = #if defined(_ CCRX__) || defined(_ GNUC__)

181

182 /* Initialize the Interrupt Table Register */

183 fFfldcf R _BSP_SET INTB(R BSP SECTOP INTVECTTBL);

Figure 6-4 Debugger start up screen

For more information on the e? studio debugger refer to the Tutorial manual. To run the code click the L&
button. The debugger will stop again at the beginning of the main function. Press B again to run the code.
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7. Additional Information

Technical Support

For details on how to use e? studio, refer to
the help file by opening e? studio, then
selecting Help > Help Contents from the
menu bar.

Window  Help

e I}éi] Welcome

) (¥)  Help Contents

Search

Show Contextual Help

For information about the RX23W group microcontroller refer to ‘RX23W Group User’s Manual: Hardware’.

For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.

Technical Contact Details

Please refer to the contact details listed in section 9 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:

https://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe GmbH.

© 2019 Renesas Electronics Europe GmbH. All rights reserved.
© 2019 Renesas Electronics Corporation. All rights reserved.
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